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This handbook and software are protected by copyright.  All rights are

reserved.  No part of this document or software may be reproduced

(using any kind of system, including but not limited to optical, electro-

nic, magnetic, biological, chemical, mechanical, and acoustical

systems), transmitted, transcribed, stored, processed, given to another

party, or translated into any language, including computer languages,

without the prior written consent of  Village Tronic Marketing GmbH.

This product was created with great care.  Unfortunately we can not

guarantee that no problems will arise.  Neither Village Tronic Marke-

ting GmbH nor the authors can be held liable  or in any way responsi-

ble for possible errors or incidental consequential damages  in connec-

tion with this material or the software.  Suggestions for improvement

are always welcome.

Village Tronic Marketing GmbH
Mühlenstr. 2
D-31157 Sarstedt

Apple, the Apple logo, Power Macintosh and Macintosh are trademarks of Apple Compu-
ter, Inc., registered in the US and other  countries.  Nubus is a trademark of Texas Instru-
ments.  Village Tronic, VideoPublishing, MultiBridge, MultiEndian and MultiBus are regi-
stered trademarks of Village Tronic Marketing GmbH.
Other company and product names mentioned in the handbook are trademarks of their res-
pective companies.  Exclusion of the trademark symbol does not indicate that  a label is a
free trade name.  Mention of products which are not from Village Tronic is for informatio-
nal purposes only and is not a misuse of a trademark.  Village Tronic Marketing GmbH
shall not be held liable for the choice, performance or use of this product.  
This documentation was created on an Apple Macintosh with  QuarkXPress 3.3.2, Macro-
media Freehand 7.0.1, Adobe Photoshop 4.0, a digital camera and a graphics converter.
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1. General Information
The Mac-Paloma module expands the MacPicasso 540 graphic
card to enable it to display video and TV images on the moni-
tor, as well as to save individual fixed-images  in all formats
that QuickTime™ offers.  At the same time, this module offers
3 different image sources (TV, Cinch and S-VHS input), as well
as 3 audio sources (Mac-Audio, Audio1 and Audio2, as well as
TV-Audio).  Audio input is emitted via an output port by means
of the included software.

The picture signal representation runs entirely on the graphic
card, completely independent of the computer processor.

2. Installation of MacPaloma
2.1 Connecting the MacPaloma to the MacPicasso 540

The MacPaloma, with its long panel of male connectors, is
attached directly to the long panel of female connectors on the
MacPicasso 540 (in future referred to as MP540).  In order to
do this the connectors of the MacPaloma must be lined up with
those of the MP540 so that the metal coverings are touching.
Then, from under the MP540 and through the appropriate holes
in the circuit board, the 3 plastic screws (included) should be
attached to the plastic support of the MacPaloma.  After this the
Paloma is ready to be installed in the computer.

If the screws do not fit, please check if the connector panel has
been correctly attached to the MP540.

To avoid eventual damage due to incorrect installation, please
contact one of our service technicians if there are any problems.
A list of contact addresses can be found at the end of this hand-
book.
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Installation

2.2  Installation in the computer

• Open your computer

• Touch the recessed metal parts in the back panel to    
discharge static electricity from your body.  (Unplug the 
power cord, which should still be plugged into a properly 
grounded outlet, only after this step.)

• Remove the casing covers from 2 connecting slots

• Carefully (!!!) insert the MP540 / MacPaloma combination 
into a free slot so that the card fences from the Paloma and 
MP540 cover the  exposed casing openings.

• Insert the screws into the card fences and tighten them, or, as
the case may be, be sure that the plastic hooks have snapped 
properly into place.

• Close the computer.

• Start the computer and install the included software. 

2.3  Software installation

The program Paloma must simply  be copied from the disk to
your chosen location on your hard drive.  When you first start,
the program will display that no default data was found.  All
settings  will then be put at standard levels.  When you quit the
program the actual settings will be saved in order to be used
again the next time you start the program.

In order for the program to function properly, Version 2.5 (or
later) of QuickTime™ must be installed.



2.4 Internal connections

Behind the Mac-Input port and the master output  port there are
two connectors with two rows of four prongs each (of which
the outer two contacts are connected to jumpers).  Here on the
internal motherboard contacts you can feed the audio directly
into the CD Audio Input port on the Mac motherboard.  The
second connection is used to feed the CD Audio signal into the
MacPaloma.

For internal cabling please follow the following steps and the
four illustrations on the following page.

1) Remove the CD-Audio Input from the motherboard

2) If needed, lengthen the cable from the CD-ROM with the 
included cable set

3) Connect the CD-ROM to the MacPaloma

4) The final step is to connect the MacPaloma to the CD-Audio
input port on the motherboard.

6
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Bitte benutzen Sie
immer die zweite
Reihe der 4-poligen
Steckpfosten !

Please always use
the second row of
four receptacles on
the sockets.
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3. Menu descriptions
3.1 The “File” menu

• Open: opens the video window.  If the video window is 
already open, this command can not be chosen.

• Close: closes the foremost window.  This can be the video 
window or one of the configuration windows. This         
command can not be chosen if no window is open.

• Fixed-image: stops the video and saves the image that is 
being shown at that moment on your hard disk.  The desired 
picture format and quality can be adjusted beforehand.

• End: ends the program.  All settings that have been made 
will be saved in order to be used again the next time you 
start the program.  In addition all external audio sources will
be switched to mute.

3.2 The “Edit” menu

The functions offered here are only applicable in the channel
storage dialog in order to copy blocks of text via the clipboard.

3.3 The “Window” menu

• Picture settings: opens the window with the picture      
options

• Audio settings: opens the window  with audio options

• Station settings: opens the widow with station options

• Open video window: opens the video window

• video window size: in this sub-menu it is possible to   
choose one of four standard video window sizes.
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3.3.1 The category Video Window Size

• Half size: switches to half of the size of the window

• Normal: switches to a 1:1 size ratio

• 150%: increases the size to 150%

• Full Screen: fills the entire screen (the menu bar remains 
visible)

• Full Screen 2: fills the entire screen (the menu bar becomes
invisible)

3.4 The “Language” menu

• German: switches to German dialogs and menus

• English: switches to English dialogs and menus

3.5 The “Help” menu

“Help” explanations can be turned on or off here.
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4. Description of the main window

The video image from the most recently chosen source is
shown in the main window.    Information about which input
port has been chosen and which stored station or channel it is
set to will be shown in the header.

In the footer of the window you can choose the input port,
change the color standard, choose the desired station from the
list of saved ones and use the arrow to move the station up and
down.

• Tuner switches to the video source TV-Tuner

• S-VHS turns to the video source which is attached to the   
S-VHS connection

• Cinch switches to the video source which is attached to the 
Cinch connection
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• PAL switches to the color standard PAL

• NTSC switches to the color standard NTSC

• Secam switches to the color standard Secam

• Auto activates automatic station standard recognition

The pop-up menu shows the presently active station. To choose
another station all you have to do is click on the menu and the
choice of  desired program.  The actual station in use is
indicated with  a check mark.

moves up in the list

moves down in the list
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5. Description of the dialog
5.1 Picture settings

In the Input space you can choose one of three connectable
video sources.  When choosing a video source the color stan-
dard will automatically return to the settings last used with this
input port.

In the Picture style space you can choose between composite
(FBAS) and S-VHS (separate cables for Crominanz and Lumi-
nanz).  The picture style S-VHS is only available when Input is
set to the S-VHS connection since this is the only Input port
that supports this function.

In the View space you can choose if you would like the images
to be shown interlaced or non-interlaced ( the vertical resoluti-
on is halved).  

Interlaced is good for images with relatively little movement.
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When there is more movement the non-interlaced mode is the
better choice in order to avoid choppy  movement.  In monitor
displays of up to 1152x870 in 75 Hz it is also possible to
connect  interpolation so that the edges will become softer.

In the area Video Standard you can switch between the diffe-
rent color standards PAL, NTSC and Secam, as well as between
the sub-standards, PAL and NTSC.  In addition, here it is also
possible to turn on automatic color standard recognition.  If
Input is set to TV all color standards are blocked, except for
PAL  B,G,H,I and automatic because the built-in TV tuner for
the German speaking market only supports this one color stan-
dard.  In the US version a NTSC tuner is used, so  all the other
color standards except  for NTSC and automatic are blocked.

Finally, it is also possible to adjust the brightness, color and
contrast within Picture Settings.  These can be changed by
clicking and dragging within the gray  area of the scroll bar (for
bigger steps) or clicking on the arrow (single steps).
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5.2  Audio SettingsThe window is divided into five segments.
They are, from left to right:

1. Master: the volume of the mixed Output (which, for    
example, can be  sent to an amplifier or speakers) 
is adjusted here.

2. Tuner: the volume of the TV receiver is adjusted here

3. Mac : the volume of the blended in Mac-Audio is adjusted
here. In this way the Mac-Audio, can be heard 
along with the other audio sources on a pair of 
speakers or an amplifier.

4. S-VHS: the Input volume associated with the S-VHS picture
signal input is adjusted here.

5. Cinch: the Input volume associated with the Cinch picture 
signal input is adjusted here.
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The balance of the signals is adjusted in the lower part of the
area.  The button under the Balance Adjuster can be used to
reset it to the middle position.

At the very bottom there is a check box with which you can
determine if the volume control is securely connected to the
appropriate picture signal input.  This means that all audio sig-
nals, except for the Mac-Audio, are switched to mute when the
image input is switched.  By a new change in the Input the
appropriate volume setting would be restored and all other
audio sources switched to mute.

5.3 Station Settings and Program Memory

In this dialog you can call up the stored stations, look for new
stations and then save these in the list.  Furthermore, saved sta-
tions can be deleted in order to free up more storage space.
There are as many storage spaces as there are possible
channels.  
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All of the saved stations are listed in the upper left area.  With
the scroll bar on the right side of the list it is possible to reach
entries that are not visible.  To choose one of these entries sim-
ply click on it with the mouse.

To the right of the station list there is the choice of frequencies.
Here you can choose a station manually.  Stations that have
already been saved will be shown. 

Below this there is a button to search for stations with.  If this
button is pressed the program will automatically search for the
next station.  The frequency will also change automatically
when necessary.

The next button is used to save stations.  There are 106 station
slots available.

The next button deletes the presently active station after a war-
ning message.

You can also choose channels directly with the scroll bar under
the text with the channel numbers.  The active station at the
time is shown above it.  This control is automatically adjusted
when station search is being run.

At the bottom on the left there is a control for fine tuning.  This
can be brought back to the middle position by pushing the but-
ton under it.   The fine tuning is saved extra for each station.  
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5.3.1 Channel memory 

In this dialog box it is possible to enter a name for the station
which is to be saved and to choose if it should be saved in the
next available slot or one to be chosen freely.  The field in
which the number can be entered can always contain the next
available number when it is called up.  Unless, of course, only
the fine tuning of an active channel has been changed.  In this
case the actual number and name are entered.  The possibility
to use the next available number is blocked. 
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6. Keyboard Shortcuts
• The up and down arrows move up and down among the 

saved channels.

• the left and right arrows change the volume of the active 
video source

• in full screen mode the ESC key can be used to restore the 
previous screen size

7. Terminal Assignments
The terminal assignments are, from left to right:

• 1 antenna – input

• 2 Cinch – input

• 3 S-VHS – input

• 4 Audio 1 (assigned to the Cinch socket) – input

• 5 Audio 2 (assigned to the S-VHS socket) –input

• 6 Mac – Audio – input

• 7 Master – Audio – output

1

2

3

4

5

6

7
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8. Terminal Specifications
Antenna connection (VHF, UHF)

FBAS Input, Cinch socket, terminated with 75 Ohm.

S-VHS Input, Mini-DIN socket, terminated with 75 Ohm.

Stereo Audio Input, socket for a 3.5 mm latching connector
assigned to FBAS Input

Stereo Audio Input, socket for a 3.5 mm latching connector
assigned to S-VHS Input

Stereo Audio Input, socket for a 3.5 mm latching connector,
can be used as input port for Mac Audio output - instead - the
introduction of the MacPaloma in the internal CD-ROM Audio
socket of the Mac, which is normally used internally for audio
from CD-ROM.(*)

Stereo Audio Output, socket for a 3.5 mm latching connector
can be used as output port in place of the Mac Audio Output
when the MacPaloma - not - is entered in the internal CD-ROM
Audio socket of the Mac, which is normally used internally for
audio to Mac motherboard.

(*)  We recommend not to use these connections, but instead to
create an internal connection from the CD-ROM audio to the
motherboard of the Mac by using the two cables which we have
included. 

There are other possible connection variations in addition to the
internal and external audio connections which were described
here.  The MacPaloma has an audio mixer with four input ports
and one output port.  This mixer could be activated before the
Mac Audio Input or completely separately.
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Help and contact addresses

If you have problems or questions about MacPicasso 340, plea-
se try to find a solution with the help of this handbook.  If you
can’t find an answer in the material provided, please contact
your dealer.  If you purchased MacPicasso directly from Village
Tronic or your dealer  could not help you, our support is there
for you.  The preferred means of communication is e-mail.  The
e-mail address is:

support@village.de

Naturally we are also available via Fax, letter or telephone.
The address and Fax and telephone numbers are at the end of
the chapter.  Please understand that our support is not available
at all times and places.

In the WWW you will find us at http://www.villagetronic.com.
There we provide new versions of the programs for MacPicasso
and additional information.

Village Tronic Marketing GmbH
Mühlenstraße 2
D-31157 Sarstedt
Telefon: +49 (0)5066/7013-0
Telefax: +49 (0)5066/7013-49
e-mail: sales@villagetronic.com

support@village.de
marketing@villagetronic.com
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